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Slide notes

Welcome to the Group Health Plan (GHP) Process Reporting Options course.
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Disclaimer

While all information in this document is believed to be
correct at the time of writing, this Computer Based
Training (CBT) is for educational purposes only and does
not constitute official Centers for Medicare and Medicaid
Services (CMS) instructions for the MMSEA Section 111
implementation. All affected entities are responsible for
following the instructions found at the following link:
https://www.cms.gov/medicare/coordination-benefits-rec
overy/mandatory-insurer-reporting-group-health-plans.

Slide notes

While all information in this document is believed to be correct at the time of writing, this Computer
Based Training (CBT) is for educational purposes only and does not constitute official Centers for
Medicare and Medicaid Services (CMS) instructions for the MMSEA Section 111 implementation.

All affected entities are responsible for following the instructions found at the following link: CMS GHP
Website.
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Course Overview

* GHP Reporting Options
= Basic
= Expanded

Slide notes

This learning module explains the data reporting options, Basic and Expanded, which are available to
Responsible Reporting Entities (RREs) to assist them in complying with Section 111. It includes file
types and descriptions required for each reporting option.
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GHP Reporting Options

» Basic Reporting Option

= Minimum compliance

requirements (i.e. GHP
coverage information only)

* Expanded Reporting Option
= Minimum compliance requirements
= Plus prescription drug coverage
information

Slide notes

Section 111 requires GHP Responsible Reporting Entities (RREs) to provide CMS with information
regarding hospital and medical coverage supplied to Medicare beneficiaries.

If the beneficiary expands or reduces their insurance coverage, first terminate the record by providing
an end date and then send an add record with the updated coverage.

Section 111 also contains provisions for CMS to share Medicare Part A (hospital) entitlement, Part B
(medical) coverage, and Part C (Medicare Advantage) information with the RRE.

RRE may choose one of two reporting options, Basic or Expanded, to comply with Section 111
requirements.

The Basic Reporting Option reflects the minimum requirements the RRE must adhere to in order to
comply with Section 111.

If the RRE chooses the Basic Option, they will be required to provide GHP coverage information only
and CMS will share information regarding Medicare Parts A, B, and C.
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The Expanded Reporting Option includes the minimum requirements for Section 111 plus the exchange
of prescription drug coverage information.

The Expanded Reporting Option will be used by RRE that wish to share prescription drug coverage
information with CMS.

The RRE will use the file formats available for Section 111 data exchange to include information on
prescription drug coverage that is either primary or secondary to Medicare Part D.
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Basic Reporting Option

Includes:

= MSP Input File
- Primary medical and hospital coverage
= TIN Reference File
= TIN Reference Response File
= Optional Query Only Input File
= Corresponding response files

The BCRC provides entitlement/enroliment
information for Medicare Parts A, B, and C

= GHP RREs who report primary prescription drug coverage using the Basic
reporting option will now receive Medicare Part D enrollment information
on their response files.

Slide notes

The Basic Reporting Option includes submission of the Medicare Secondary Payer (MSP) Input File for
primary medical and hospital coverage of Active Covered Individuals, the TIN (Tax Identification
Number) Reference File, TIN Reference Response File, and optionally, the Query Only Input File, in the
form of an ANSI 270/271 Entitlement Query File, along with the corresponding response files.

The Query Only Input File will be used by the GHP to request Medicare coverage information on their
retirees. The Benefits Coordination & Recovery Center (BCRC) will only provide entitlement/enroliment
information for Medicare Parts A, B, and C with this option.

Additionally, GHP RREs who report primary prescription drug coverage using the Basic reporting option
will now receive Medicare Part D enrollment information on their response files.
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Basic Reporting Option Files

File Type Description
MSP Input File

* From the RRE to the BCRC

MSP Input File * Report information regarding
MSP Response File Active Covered Individuals
N Refren s Fie whose GHP coverage may be
primary to Medicare

TN Reference Respanse Fil

Query Only Input File

Query Only Response File

Slide notes

A brief description of the files used in the Basic Reporting Option are as follows. The exact file formats
and record layouts are provided in the appendices of the GHP User Guide.

MSP Input File: This is the data set transmitted from an MMSEA Section 111 Responsible Reporting
Entity to the BCRC that is used to report information regarding Active Covered Individuals whose GHP
coverage may be primary to Medicare.

Note: Section 111 RREs who receive RX 07 error codes when submitting drug records for beneficiaries
who have not yet enrolled in a Medicare Part D plan can resubmit records that received this error on
your first file submission of the next calendar year or monitor the individual’s Medicare Part D
enrollment status by logging in to the Section 111 COBSW portal and using the Beneficiary Lookup
Tool.

Please make note that there are Special Enrollment Periods (SEPs) that can make a Medicare
beneficiary qualify for Part D. It is the RRE’s responsibility to ensure correct reporting.
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To provide more accurate direction to submitters, instead of receiving the RX 07 error code

(Beneficiary does not have Part D enrollment), Disposition Code 51 will be returned for those records
where the submitted individual is not entitled to Medicare Part D.
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Basic Reporting Option Files

File Type Description
MSP Response File

* From the BCRC to the RRE

MSP Input File » Respond with corrections
MSP Response File and/or changes to MSP Input

TIN Reference File Flle

IN Reference Response Fil

Query Only Input File

Query Only Response File

Slide notes

MSP Response File: This is the dataset transmitted from the BCRC to the Responsible Reporting Entity
after the information supplied in the Responsible Reporting Entity’s MSP Input File has been
processed.
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Basic Reporting Option Files

File Type Description
TIN Reference File
* From the RRE to the BCRC

MSP Input File * Provide RRE’s Federal TIN and
associated mailing address

MSP Response File

TIN Reference File

e Submit with the MSP Input File
or as a separate file

IN Reference Respaonse Fi

Query Only Input File

Query Only Response File

Slide notes

The TIN Reference File consists of a listing of each business entity’s Federal Tax Identification Number
(TIN) and the business mailing address that is linked to that particular TIN.

This file can be submitted along with the MSP Input File in one physical file transmission or as a
separate file.
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Basic Reporting Option Files

File Type Description
TIN Reference Response File

* From the BCRC to the RRE
= After information supplied
MSP Input File in TIN Reference File has
MSP Respense File been processed

TIN Reference File

TIN Reference Response Fil

Query Only Input File

Query Only Response File

Slide notes

TIN Reference Response File: This is the data set transmitted from the BCRC to the RRE after the
information supplied in the RRE’s TIN Reference File has been processed.
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Basic Reporting Option Files

File Type Description
Query Only Input File

* From the RRE to the BCRC

MSP Input File * Request Medicare Part A
MSP Response File entitlement and Parts B and C
enrollment information of
potential Medicare
beneficiaries

TIN Reference File

IN Reference Respaonse Fil

Query Only Input File

Query Only Response File

Slide notes

Query Only Input File: This is a query file used to obtain Medicare Part A entitlement and Parts Band C
enrollment information of potential Medicare beneficiaries.
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Basic Reporting Option Files

File Type Description
Query Only Response File

* From the BCRC to the RRE

* Return Parts A, B and C coverage
information for individuals identified as
MSP Response File Medicare beneficiaries

MSP Input File

TIN Reference File

* As of July 2019, GHP RREs who report

IN Reference Response Fil primary prescription drug coverage using
the Basic reporting option will now
receive Medicare Part D enrollment
information on their response files.

Query Only Input File

Query Only Response File

Slide notes

After the BCRC has processed the Query Only Input File, it will return the Query Only Response File
with Medicare Parts A, B, and C coverage information for individuals identified as Medicare
beneficiaries.

GHP RREs who report primary prescription drug coverage using the Basic reporting option will now
receive Medicare Part D enrollment information on their response files.
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Expanded Reporting Option

* Includes:
= MSP Input File

o Primary medical, hospital and prescription drug coverage
TIN Reference File
TIN Reference Response File
* Optional Query Only Input File
Non-MSP Input File

o RDS and supplemental prescription drug coverage records
* Corresponding response files

* The BCRC provides entitlement/enrollment information for
Medicare Parts A, B, C, and D.

* Must provide drug coverage on a regular basis

Slide notes

The Expanded Reporting option includes the MSP Input File for primary medical, hospital, and
prescription drug coverage for Active Covered Individuals, the TIN Reference File, TIN Reference
Response File, the optional Query Only Input File and the Non-MSP Input File.

The Non-MSP Input File is used to report information regarding the prescription drug insurance
coverage information of your Inactive Covered Individuals.

This File can also be used to query CMS about potential beneficiary Medicare Parts A, B, C, and D
coverage.

Additionally, the Non-MSP Input File may be used as a way to submit retiree files to the Retiree Drug
Subsidy (RDS) Center on behalf of Plan Sponsors claiming the Retiree Drug Subsidy.

The Expanded Reporting Option will also include corresponding response files.

The BCRC will provide entitlement/enrollment information for Medicare Parts A, B, C, and D with this
option.
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If you choose the Expanded Reporting Option, you must provide CMS with information about drug
coverage for Medicare beneficiaries on a regular basis in the form of primary drug coverage on the

MSP Input File, or supplemental drug coverage records or RDS retiree file records on the Non-MSP
Input File.

To ensure that a drug record is not created with a missing or invalid insurer name when an RDS record

is received through a VDSA, a valid insurer name is now required when the submitted Action Type is
lls".
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COBA Partners Only - Expanded Option

May submit information using the COBA EO02 record

Note during registration

The BCRC will track COBA submissions accordingly

Slide notes

If you currently maintain a Coordination of Benefits Agreement (COBA) with CMS for the purposes of
crossing over claims paid by Medicare for secondary payment by your plan, then you may submit
supplemental prescription drug information using the COBA E02 records and still remain compliant
with the requirements of the Section 111 Expanded Reporting Option.

If you choose this reporting option, please note this during the Section 111 registration process. The
BCRC will track your COBA submissions accordingly.
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Expanded Reporting Option Files

File Type Description
Non-MSP Input File « From the RRE to the BCRC

MSP Input File » Report information regarding
R the drug insurance coverage
e information of Inactive
Covered Individuals

IN Reference Response Fil

Non-MSP Input File

Non-MSF Response File

Query Only Input File

Query Only Response File

Slide notes

The following section explains the Expanded Reporting Option in further detail. In addition to the MSP
Input File, MSP Response File, TIN Reference File, TIN Reference Response File, Query Only Input File
and Query Only Response File included in the Basic Reporting Option, the Expanded Reporting Option
includes the Non-MSP Input File and Non-MSP Response File.

The exact file formats and record layouts are provided in the appendices of the GHP User Guide.

Non-MSP Input File: This is the data set transmitted from a Responsible Reporting Entity to the BCRC
that is used to report information regarding the drug insurance coverage information of Inactive (e.g.
not employed, retired) Covered Individuals.

Page 17 of 21



GHP Process Reporting Monday, July 01, 2024

Slide 15 of 18 - Expanded Reporting Option Files

Expanded Reporting Option Files

File Type Description
Non-MSP Response File

From the BCRC to the RRE

SSPithiiEls Information processed
MSP Response Fils regarding Inactive Covered
TIN Reference File IndiViduaIS

IN Reference Response Fil

MNon-MSP Input File

Non-MSP Respense File

Query Only Input File

Query Only Response File

Slide notes

Non-MSP Response File: This is the dataset transmitted from the BCRC to the Responsible Reporting
Entity after the information supplied in the Non-MSP Input File has been processed.
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Course Summary

* GHP Reporting Options
» Basic
* Expanded

S ummary

Slide notes

This learning module explained the data reporting options, Basic and Expanded, which are available to
Responsible Reporting Entities to assist them in complying with Section 111. It included file types and
descriptions required for each reporting option.
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COB:R

Coardinafion of
Benefits and Recovery

You have completed the GHP Process Reporting Options
course. Information in this course can be referenced by
using the GHP User Guide’s table of contents and any

subsequent alerts. These documents are available for
download at the following link:
https://www.cms.gov/medicare/coordination-benefits-rec

overy mandator—insurer—reorﬁn—rou—health—lans.

Slide notes

You have completed the GHP Process Reporting Options course. Information in this course can be
referenced by using the GHP User Guide’s table of contents and any subsequent alerts.

These documents are available for download at the following link: CMS GHP Website.
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COB:R

Coardinafion of
Benefits and Recovery

If you have any questions or feedback on this material,
please go to the following URL:

https://www.surveymonkey.com/s/GHPTraining.

e
TRAINING SURVEY

Slide notes

If you have any questions or feedback on this material, please go the following URL: GHP Training
Survey.
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